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Lab Exercises and Solutions 

 
 

Lab 1 
 

 
1.1 Starting Word 

 
To Start word, follow these steps. 
 
1. Click on the ‘Start’ button. 
 
2. Select the option ‘Programs’, as shown in Fig. 

 

 
 
3. Click the ‘Microsoft Word’ option, a Document will be opened as shown in 

Fig. 
 
 
 

Microsoft Word  2000 
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1.2 Creating Documents 

 
 For creating a new document do the following steps: 
 
1. Type the following text in the workspace area: 
 
This screen is seen every time Microsoft Word 2000 is started. Now you are 
ready to type the document in the workspace available. 

 
Word 2000 is a tool based on the concept of word-processor. It is an integrated part of 
Office 2000 that is developed by Microsoft Corporation. Today, it is the world’s most 
popular word-processor. The competitors to the Word package are WordPerfect and 
Ami Pro (Part of Lotus Smart Suite).  Although every word-processor provides almost 
the same features, Word 2000 is most flexible to work with. 
For saving the file perform the following steps: 
 
2. Select ‘File’ option from Main Menu. 
 
3. Click the ‘Save As’ option, screen as shown in Fig. 
 

Menu Title Bar Tool Bar Ruler Line 
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4. Type ‘MYDOC’ in the filename textbox after erasing the contents in the 

box. 
 
Word automatically gives an extension  .doc to the file. Thus the file is saved 
with the name mydoc.doc. 
 
For closing the document do the following steps: 
 
Before closing the document see to you that the file is saved first. 
 
5. Select ‘File’ option from Main menu. 
6. Click ‘Close’ option from the menu. 

 
1.3 Opening a Word document 

 
For opening a word document do the following steps: 
 
1. Select ‘File’ option from Main Menu. 

2. Click on the ‘Open’ option as shown in Fig. 

3. Click on the file from the available list. 

4. Click on ‘Open’ button. 

 
The selected file will be opened. 
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1.4 Cutting, Copying and Pasting Text 
 
You may require to use the same piece of information at more than one place, 
instead of typing it again you can use the feature of cut, copy and paste 
provided by word. Follow the steps to do so. 
 
1. Select the text or picture you want to Cut or Copy. 
 
2. Click on the appropriate icon from the toolbar, icons as shown in Fig. 

                                   
3. Place the cursor where you want to paste the text  or picture. 
 
4. Click on ‘Paste’ icon from the toolbar to paste. 
 

1.5 Modifying Font 
 
Certain text can be displayed in a different format to highlight a particular 
point .For doing so perform the following steps: 
 
1. Select the text for which you want to change the Font. 

2. Select the Font drop-down list box button as shown in Fig. 

3. Click on the font ‘Arial’ in the font list box. 

Cut 

Copy 

Paste 
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4. Select the text for which you want to change the Font size. 

5. Select the font size drop-down list box as shown in  the Fig . 

6. Click ‘14’ in the font size list box. 

 

 
 
7. Select the text for which you want to change the font to bold style. 

8. Click ‘Bold’ button.  You can undo the effect by clicking on the same 

button again. 

9. Select the text for which you want to change the font to italic style. 

10. Click ‘Italic’ button. 

11. Select the text you want to underline. 

12. Click ‘Underline’ button. Undo the effect by clicking the same button 

again. 

 
Note: Bold, Italic, Underline buttons are toggle buttons. 
 

1.6 Aligning Text 
 
1. Select the text for which you want to align to the center of the line. 
 
2. Click the ‘Center’ button as shown in Fig. 
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3. Select the text you want to align to the right of the line. 

4. Click on the ‘Align right’ button as shown in Fig. 

5. Select the text you want to align to the left of the line. 

6. Click on the ‘Align left’ , button as shown in Fig. 

 
To take care that the text written is always aligned properly with the margins 
specified and to get perfect justification of the text on the either side of the 
line. 
 
7. Click on the ‘Justify’; button as shown in Fig. 
 
Note  :  It is recommended that whenever working with a new document 

always keep the alignment in the ‘Justify’ mode for proper alignment of 
text. 

 
1.7  Indenting Paragraphs and modifying line spacing 

 
1. Select the paragraph for which you want to set the indenting. 

2. Click ‘Increase Indent’ as shown in Fig.  

                                                        

 
 
3. Click ‘Decrease Indent’ as shown in Fig used to remove the indenting. 

4. Select the paragraph you want to set the line spacing. 

5. Select the ‘Format’ option from Main Menu. 

6. Click ‘Paragraph’ option , a dialogueue box as shown in Fig appears. 

             

Left 

Right 

Center 

Justify 
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7. Select ‘Line Spacing’ list box from the dialogueue box. 
8. Click on ‘Double’ option from the list box. 

 
1.8 Setting and Modifying Tabs 

 
To modify the existing tabs do the following steps: 
 
1. Select ‘Format’ option from Main menu. 
2. Click ‘Tabs’ option, screen as shown in Fig will be displayed. 
 

 
 
3. Enter ‘1’ in the text box for ‘Tab’ stop position. 
4. Click ‘Set’ button. The new tab position is set. 
5. To remove any unwanted tab stop select the tab from the list. 
6. Click ‘Clear’ button. The tab is removed. 
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7. Click ‘Clear All’ button to remove all the tabs set currently by you. 
8. Click ‘OK’ button to reflect the changes made now on  to the document. 

 
1.9 Inserting Numbers and bullets in the word document 

 
1. Type the following text in the document currently open. 

 
Ceat Cricket Ratings: 
Sachin Tendulkar. 
Brain Lara. 
Steve Waugh. 
Alec Stewart. 
Nathan Astle. 

 
2. Select only the name from the text you have typed. 

3. Select the ‘Format’ option from the Main menu. 

4. Click ‘Bullets and Numbering’ option. 

5. Screen as shown in fig will appear.                 

 

 
 
6. Click the bordered box. 
7. Click ‘OK’ button. Names will be numbered accordingly. 

 
1.10 Inserting Bullets 
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1. After giving the number to the players, continue the document with the 
following text. 

 
Rules & Regulations: 

 
 Batsmen gets 2 points after 50 runs and 3 addition points for a hundred. 

 
Bowler gets 1 point for every 2 wicket and 3 additional point for a haul of 5 
wickets. 

  
 Fielder gets 1 point for every catch. 

 
2. Select the text after the ‘Rules & Regulation’ line. 

3. Select ‘Format’ option from the Main menu. 

4. Click ‘Bullets and Numbering’ option. 

5. Click the ‘Bulleted’ tab page, as shown in Fig.                

 

 
 
6. Select the ‘Arrow Mark’ bullets . Refer the Fig. 
7. Click ‘OK’ button.  
 
The rules are bulleted now. 

Lab 2 
 

 2.1 Inserting Header and Footer to the document 
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While preparing a report,  you may want some information to appear on 
every page, for example company name, report title or page number. This 
information would normally appear either in the top or bottom of the page. 
You can insert this using Header and Footer option. To do so follow these 
steps. 

 
1. Select on the ‘View’ option of the Main Menu. 
2. Click on the ‘Header and Footer’ option. The screen as shown in Fig will 

be displayed. 
3. Click on ‘Insert Date’ icon on the ‘Header Footer Toolbar’ to insert date on 

the header. 
4. Press a ‘Tab key’ on the key board. 
5. Write ‘Radiant Software Ltd’ 

This is the header of your document. 
After adding a header to the document we move ahead to insert a footer. 

6. Click on ‘Switch between header and footer icon’ on the toolbar.        
Footer screen is displayed. 

7. Click on ‘Insert page number’ icon on the toolbar. 
8. Press ‘Tab key’ twice on the keyboard. 
9. Write ‘Annual Report’. 
10. Click ‘Close Header and Footer’ icon on the header/footer toolbar. 

 
 

11/1/2001 Radiant Software  

1/10 Annual Report 



 
 
 
 

Lab Exercises and Solutions 

Centre for Information Technology and Engineering, Manonmaniam Sundaranar University  11 

2.2 Creating Page Breaks 
 

For creating Page Breaks, do the following steps: 
 
1. Select ‘Insert’ option from the Main menu. 
2. Click ‘Break’ option. Screen as shown in Fig will be displayed. 

 
3. Click on the ‘Page Break’ button. 
4. Click on the ‘OK’ button. 
 

2.3 Using AutoCorrect 
 
Word 2000 allows us to check any grammatical error while you are typing any 
document . To use this feature do the following steps: 
 
1. Select ‘Tools’ option from the Main menu. 
2. Click ‘AutoCorrect’ option. Screen as shown in Fig will appear. 
3. Click all the Check Boxes as shown in Fig. 
4. Click on ‘OK’ button. 
 

         Now type the following text and see the effect of AutoCorrect feature: 
 
 
 
 
After the above text is typed it will be automatically displayed in the 
following way as the AutoCorrect feature will be used. 
 
  
 
 

tHis is Radiant-MSU Task Team. We are learning Word 2000 . our course 
started on october 2000 

This is Radiant-MSU Task Team. We are learning Word 2000. Our course 
started on October 2000. 
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Next Steps: 

 
5. Open the ‘AutoCorrect’ dialogueue. 

6. Place the cursor in ‘Replace’ text box. 

7. Type ‘Radian’ 

8. Place the cursor in ‘With’ text box. 

9. Type ‘Radiant’ 

10. Click on ‘OK’ button. 

 
Now type the following text and see the feature of Replace/With feature of 
Word 2000. 
 
 
 
The text will automatically turn to: 
 
 
 

 

Radian Software Ltd. Ray Of Hope.

Radiant Software Ltd. Ray Of Hope. 
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2.4 Setting Auto Text 
 

1. Select ‘Insert’ option from the Main Menu. 

2. Click ‘Auto Text’ option. 

3. A cascade menu is displayed. 

4. Click ‘Auto Text’ option. Screen as shown in Fig will be displayed.                 

 

 
 

5. Enter ‘Radiant Software Ltd’ in the text box ‘Enter Auto Text Entries’ 
6. Click on ‘Add’ button, to add the auto text. 
 

The text ‘Radiant Software Ltd’ is added to the dictionary. 
Type the following text: 

 
 
 
While you are typing Radiant you will get a bubble help, which shows the 
entire ‘Radiant Software Ltd’. 
 

We are studying in Radiant Software Ltd . 
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7. Now instead of writing the entire line just press <Enter>key. 
 

2.6 Spelling Check and Grammar Tool 
 
After the entire document is typed you can check the spelling mistakes and 
the grammatical mistakes with the help of  ‘Spelling & Grammar check tool’.  
Perform the following steps to do so: 
 
1. Type the following line in a doc. 

 
 
 
2. Select ‘Tools’ option from the Main Menu. 
3. Click ‘Spelling and Grammar’ option. The screen will look like this. 

 
This will start the Spell and Grammar check. Spell checker will provide 
certain suggestions if there are any errors. 

 
4. If you want the text according to the suggestion then, click on ‘Change’ button. 
5. Else click on ‘Ignore’ button. The right suggestion is as follows. 

 
 
 
 

2.7 Changing default settings 
 

You can change the default setting by changing the options. For changing the 
options do the following steps: 

This is a tes for spell checking. 

This is a test for spell checking. 
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1. Open the ‘Spelling and Grammar’ dialogueue. 
2. Click on ‘Options’ button . Screen will look like the one.          
 

 
 
Recheck the document by making some changes in the document and also 
some of the options in the above shown screen. 

 
2.8 Thesaurus 

 
Thesaurus is used to find a more precise expression for a given word. To 
make use of thesaurus perform the following. 

 
1. Select the word for which you want an expression. 
2. Select the ‘Tools’ option from the Main menu. 
3. Select the  ‘Language’ option from the menu. 
4. Click on ‘ Thesaurus’ option. The screen as shown in Fig will be displayed. 
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5.     If you want to replace the word with the given expression then 

 
Click on ‘Replace’ button. The word will be replaced. Instead of selecting a 
word and then activating thesaurus, you can activate thesaurus first and 
then enter word for which you require an expression.  Step for this way 
are as follows. 

 
6. Activate ‘Thesaurus’ as explained earlier. The Screen as shown in Fig will 

be displayed. 
 

7.    Write the word in the ‘Insert’ text box. 
8. Click ‘Look Up’ button. 
9. Meanings will be displayed. 
10. Select the appropriate meaning and click ‘Insert’ button to place the 

expression in the document. 
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Lab3 
 
3.1 Find Text 

 
To find a particular word throughout the document, we use the feature of 
Find. Perform the following steps: 

 
1. Select ‘Edit’ option from Main menu. 
2. Click on ‘Find’. The screen as shown in Fig appear.    

 
3. Type the text you want to find in the ‘Find What’ text box. 
4. Click on ‘Find Next’ button. 
5. Cursor will be placed at the first occurrence of the text. 
6. Click on ‘Find Next’ again button to get the next occurrence. 
 
You can continue till the end-of-document is reached. 
 

3.2 Find and Replace Text 
 
After a specified word is found you may want to replace it with some other 
word, which is possible using the replace feature. Perform the following step 
to find and replace text: 

 
1. Activate ‘Find’ dialogueue as given above. 
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2. Click on ‘Replace’ tab. The screen as shown in Fig will appear.  
3. Type the word in the ‘Replace with’ text box. 
4. Click on ‘Replace’ button, if you want to replace only the first instance. 
                                                   Or 

Click on ‘Replace All’ button if you want to replace all the instances of the 
found word. 
 
All your word ‘Institute’ will be replaced by ‘Education’. 
 

3.3 Closing the Document 
 

For closing the document do the following steps. 
Before closing the document be sure that the file is saved first. 
 
1. Select ‘File’ option from Main menu. 
2. Click ‘Close’ option from the menu. 

 
3.4 Splitting Window 

 
1. Open any document created earlier as learnt previously. 
2. Select ‘Window’ option from the Main menu. 
3. Click on ‘Split’ option. 
 
A horizontal line appears on the screen, which moves along with the mouse 
movement. 
 
4. Click the mouse button where you want the window to split .See the Fig. 

 
The Window will be split as shown in the above Fig. 
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3.5 Arranging Windows 
 

By splitting a window you can only work with a single document. But 
if you want to work with two documents simultaneously then you have 
to arrange the windows . Do the following steps to arrange windows.  

 
1. Open any two documents you want to work with at the same time. 

2. Select ‘Window’ option from the Main Menu. 

3. Click ‘Arrange All’ option. Screen as shown in Fig will appear. 

 
Now you can see both documents opened in two separate windows and you 
can modify either of them at the same time. 
 

 
 
After modifying individual documents save the files one by one, both the 
windows get their own menu bar. 

 
3.6  Working with Columns 

 
1. Select ‘Format’ option from the Main Menu. 

2. Click on ‘Columns’ option. Screen as shown in fig will appear. 

3 Click ‘Three’ from the presets group box. 

4 Click ‘Equal Column Width’ check box. 
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5 Click ‘OK’ button . Screen as shown in Fig will appear. 
 

 
 
6.    Type ‘Radiant Software Ltd’ in the first column. 

7. Select ‘Insert’ option from the Main Menu. 

8. Select ‘Break’ from the options. 

9. Click ‘Column Break’ radio button. 

10. Click ‘Ok’ button. 

11. Type ‘Ray of Hope’ in the second column. 

12. Repeat 7,8,9,10 . 

13. Type ‘Content Development’ in the third column. 

Finally you will get a screen as shown in Fig. 
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Note: 
 
Click on ‘Line between’ check box in ‘Columns’ dialogueue box, it will 
display vertical line for the columns. You can also give varying column 
widths by not checking the ‘Equal column width’ check box. You can have 
maximum 12 columns. 

 
3.7 Saving and Protecting the Document 

 
We have already saved the files many time previously, now we will see some 
more options with ‘Save’ and ‘Save As’. 
1. Create a new document. 
2. Type the text, which you want in the document. 
3. Select ‘File’ option from the Main Menu. 
4. Click ‘Save’ option. Screen as shown in Fig will appear. 
 

 
Even though we are clicking ‘Save’ option Word 2000 opens ‘Save As’ 
dialogueue box as we are saving the document for the first time. 
 
5. Type the filename in the ‘File Name’ text box. 
6. Click on ‘Save’ button. 
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The file would be saved by the given name. Next time you click on 
save the ‘Save As’ dialogueue box won’t appear as Word 2000 already 
know what is the name of the file by which is should save. You get 
more flexibility when you are working with ‘Save As’. 

 
You can change the directory where you want to save the file. You can specify 
the directory by using the popup list for the directory as displayed in Fig. 
 

3.8 Protecting documents with Password 
 
While saving a document you should also take care that when the document 
is protected form illegal access from any source. For such kind of security we 
can give password while we are saving the document. For specifying the 
password to a file do the following steps. 
 
1. Select ‘File’ option from the Main Menu. 
2. Click on ‘Save as’ option. 
3. Click on ‘Tools’ drop down. 
4. Click on ‘General Option’ . Screen as shown in Fig will be displayed. 
5. Enter the password in the ‘Password to open’ text box. 
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 Asterisk ‘*’ mark will displayed when the password is typed. 
6. Click ‘OK’ button. 

 
 
Word will ask a confirmation for the password entered.  In the above steps we had 
given password for just opening the document i.e. when anybody tries to open the file 
afterwards, Word 2000 will prompt the user for the password, screen as shown in Fig 
will appear. 
 

 
 
Do the following steps to find out whether the file is password protected. 
 
7. Close the file for which you have assigned the password. 
8. Open the same file. Before the file is opened. Word 2000 prompt for the 

password, screen will be displayed . 
9. Enter the password you have assigned. 
10. Click ‘OK’ button. 
 

If the user enters the proper password then the file will be opened and he 
can modify the file. 
 
Now you want that the user should not be able to modify the contents  if 
he is not knowing the password. For giving the password for not allowing 
unauthorized persons to modify the file do the following steps: 

 
11. Perform the step from 1 to 4 given above. 
12. Enter the password in ‘Password to modify’ text box. 
13. Click ‘OK’ button. 
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Do the following steps to find out whether the file is password protected. 
 
Close the file for which you have assigned the password. 
 

14. Open the same file. 

15. Enter the assigned password to modify the file. 

16. Click ‘OK’ button. 

 
If the user enters the proper password then the file will be opened and he can 
modify the file. 
 
17. Click on ‘Read-Only’ button to open the file for reading purpose. If open 

in read-only mode the contents of the file cannot be appended or changed. 
 

3.9 Protecting document without password 
 
1. Select ‘Tools’ option from the Main Menu. 

2. Click ‘Protect Document’ option. Screen as shown in fig will appear. 

 

 
 

3. Click ‘Track Changes’ option. 
4. Click ‘OK’ button. 
 
This will keep a track of all the changes made to the file by any other user. If 
you click on ‘Comments’ option then the user can only insert comments and 
cannot modify the contents of the file. 
 
The password is optional while protecting the document this way. 
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Lab 4 
 
4.1Creating Table 

 
In a document you may want to enter some data, which is in tabular format. 
For entering such kind of data you require a table. Following the given steps 
to do so: 
 
1. Select ‘Table’ option from Main Menu. 
2. Select ‘Insert’ option from the list. 
3. Click on ‘Table’ option. Screen as shown in Fig will appear. 
 

 
 
4.    Click on ‘OK’ button. 

 
• A table with 5 columns and 2 rows will be inserted into the document. 

• You can change the number of columns or the rows by making the 

changes in the number of column and number of rows text box 

respectively. 

• The table created above will have column cells of same width, as we have 

selected the ‘Fixed column width’ radio button. Select ‘AutoFit to contents’ 

option if you want the column width to variable width depending on what 

we enter into the cell. 

• The difference between the two types of behavior is shown in Fig. 
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If you don’t want the table of fixed width as well as AutoFit style , then you 
can go for some predefined style. Perform following steps to AutoFormat the 
table. 
 
Repeat the steps 1,2,3 as given above. 

 
5. Click on ‘AutoFormat’ button . Fig as shown  will appear. 
6. Select ‘Classic4’ from the formats list box. 
7. Click ‘OK’ button. 
 
Table with a classic4 layout will be inserted. 
 
Click the check box ‘Set as default for new tables’ if you want the same format for all 
the new tables created hereafter. 

 
Name Age Marks Rank Paper 

John 24 84 First Office Automation 

 
Instead of working with fixed column width and AutoFit width column, now 
suppose you want to have the width according to your choice. To do so 
follow the given steps: 
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8. Insert a table using any of the way discussed above. 
9. Select the column for which you want to change the width. 
10. Select ‘Table’ option from the Main Menu. 
11. Click ‘Table Properties’ option. 
12. Click ‘Column Tab’ .  
13. Enter ‘4’ in the preferred width textbox. 
14. Select ‘Measure in’ option as ‘Inches’. 
15. Click ‘OK’ button. 
 
The selected column will now have the width as 4”. The properties can be 
changed for all the columns by using the ‘Previous column’ and ‘Next 
column’ buttons. 
 

 
 
4.2 Adding Columns and Rows to the table 

 
As data keeps on changing, new data is bound to come in. For that we require 
to add either columns or rows afterwards. So these are the steps for adding 
columns or rows. 
 
1. Select the table in which you want to insert a column. 
2. Select ‘Table’ option from Main Menu. 
3. Select ‘Insert’ option. 
4. Click ‘Column to the left’ or ‘Column to the right’ 
 
A blank column gets inserted either to the left of the existing column. 
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5. To insert a row repeat the first 3 steps given above. 
6. Click either ‘Row above’ or ‘Row below’ 
 
A blank row gets inserted either above or below the existing row. 

4.3 Deleting columns or rows from the table 
 
To delete the columns or rows from the table do the following steps: 
 
1. Select ‘Table’ option from the Main Menu. 
2. Select ‘Delete’ option. 
3. Click ‘Row’ to delete the entire row or click ‘Column’ to delete the entire 

column or  click ‘Cell’ to delete the specified cell . 
 
The specified column, row or the cells gets deleted. 

 
4. If you want to delete the entire table then click ‘Table’ option. 
 
The entire table gets deleted. 
 

4.4 Splitting and merging cells 
 
After the table is inserted you may want to enter two values in a single cell or 
else you want to use the space of two cells to enter a single value for doing so 
you have to split or merge the cells respectively. Perform the following steps 
to do so: 

 
1. Select the cell, which you want to split. 
2. Select ‘Table’ option from Main Menu. 
3. Click ‘Split Cell’ option. Screen as shown in Fig will appear. 

 

 
 
4. Enter ‘2’ in the number of columns text box. 
5. Click ‘OK’ button. 



 
 
 
 

Lab Exercises and Solutions 

Centre for Information Technology and Engineering, Manonmaniam Sundaranar University  29 

 
The cell gets split into two parts. For Merging two or more cell do the 
following steps: 
 
6. Select the cells you want to merge together. 
7. Select ‘Table’ option from Main Menu. 
8. Click ‘Merge Cells’ option. 
 
The selected cells get merged together. 

4.5 Text alignment within Tables 
 
The text is always left justified and starts from top most corner of the cell. You 
can change this alignment with the help of table properties. Perform the 
following steps to do so. 
 
1. Select the cell for which you want to change the alignment. 
2. Increase the cell height. 
3. Select the ‘Table’ option from the Main Menu. 
4. Click on ‘Table Properties’ option. 
5. Click on ‘Cell’ tab. Screen as shown in fig will appear. 
6. Click ‘Center’ from the vertical alignment group box. 
7. Click ‘OK’ button. 
 

 
 
Now whatever you type it will be displayed in the middle of the cell. 
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4.6 Changing text orientation 

 
You can also change the direction of the text displayed in the cell. Usually it is 
horizontal and from left to right . Perform the following steps to do so: 

 
1. Select the cell for which you want to change the direction. 
2. Select ‘Format’ option from Main Menu. 
3. Click on ‘Text Direction’ option . Screen as shown in fig will be displayed. 

 
4. Click the vertical style of orientation as shown in Fig. 
5. Click ‘OK’ button. 
 

Na
me 

Age Mark
s 

Ra
nk 

Paper 

Jo
hn

 

24
 

84
 

Fi
rs

t 

O
ffi

ce
 

A
ut

o
m

at
io

n  

 
The text typed hence will be displayed vertically in the cell. 
 

4.7 Adding Calculations 
 
You may want to show some output by calculating the values from the other 
cells. You can do this with the help of formula. Perform the following steps to 
do so. 

 
1. Select the cell in which you want to display the output. 
2. Select ‘Table’ option from Main Menu. 
3. Click on ‘Formula’ Option. 
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4. Enter ‘=Sum(ABOVE)’ if the values for which you want the sum are above 

the cell where you want to display the sum. OR Enter ‘=Sum(LEFT)’ if the 
values are at the cell where you want to display the sum. 

 
5. Click ‘OK’ button to get the sum. 
 
You can change the format of the output by changing the ‘Number format’ 
option. 
You can also choose the functions with the help of ‘Paste Function’ option. 
 

 
 
Lab 5 

 
5.1  Creating Main Document 

 
When you are working with Merge Documents we normally work with two 
different documents, firstly the Main Document, which actually contains the 
body matter, Which is common for all , and the other document is the merged 
document. You will first create a main document follow the steps  given 
below. 

 
1. Select ‘Tools’ option from Main Menu. 
2. Click ‘Mail Merge’ option, screen as shown in Fig will appear. 



 
 
 
 
Computer Fundamentals and Office Automation 

         Centre for Information Technology and Engineering, Manonmaniam Sundaranar University 32 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
3. Click ‘Create’ button.  A dropdown list box is displayed. 

4. Click ‘Form Letter’ option, screen as shown in Fig will display. 

 
 
 
 
 
 
 
 

5. Click ‘Active Window’ if you want to create the current window  in the 
Main Document. 
                                             Or 
Click ‘New Main Document’ if you want to create a new document as a 
main document. 

 
6. Click ‘Close’ button. 
 
7. Write the following text, which you want to be common for all the letters. 

 
 
 
 
 

To, 
 
 
Dear 
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This is to inform you that you have cleared the written test with grade. You 
are required to come for the interview on 

 
 
 
 
 
 
8. Save the File. 

 
5.2 Creating Data Source 

 
Once you are through with the main document , you will create data source.  
Perform the following steps to do so: 

 
1. Activate the ‘Mail Merger Helper’ window as explained above in Step 

1&2. 
2. Click ‘Get Data’ button. A dropdown list box is displayed. 
3. Click ‘Create data source’ option , screen  as shown in Fig will appear.           

 

 
 

4. The ‘Field names in header row’ list box shows all the possible field names 
you may require. The fields that are not required can be removed by 
clicking on ‘Remove Field Name’ button. 

 

Thanking You, 
 
For  Macro Soft 
Mr. Stone. 
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5. Select FirstName, LastName, Address1, Address2, Postalcode from this list 
box and remove the rest of the fields. 

 
6. Type ‘Grade’ in the ‘Field Name’ text box and click ‘Add Field Name’ 

button to add this additional field . Repeat this step for ‘Date’ and ‘Time’. 
 

7. Click ‘OK’ button after all the fields you want are ready. Now word will 
ask you save the data source by prompting you the ‘Save As’ dialogueue 
box. 

 
8. Save the file. Once you saved the file screen as shown in Fig will appear. 

 
9. Click ‘Edit Data Source’ button. Enter the data shown as per Fig.            
 

 
 

10. Click ‘Add New’ button and enter the following data. 
 
11. Click ‘OK’ after entering all the records. 
 

The data source gets created. The control is transferred to the main 
document .You will also notice the toolbar as shown in Fig. 
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This is a ‘Mail Merge’ toolbar, which allows you to work with mail merge 
documents. 
 
Now you have to insert the merge fields into the main document. Position the 
cursor on the next line after ‘To’ , in the main document. 
 
12. Click ‘Insert merge Field’ button. A drop down list is displayed. 

13. Select the ‘Firstname’ field. 

14. Press <Enter Key> 

15. Click ‘Insert merge Field’ button. 

16. Select ‘Address1’ field. 

17. Repeat the above steps for inserting all the fields in the main document. 
After all the fields are inserted, the file should look like the Fig. 

 
 

 
 
18. Click ‘View Merged data’ button to preview the merge data in the main 

document. 
19. You can scroll through the pages by using the ‘First Record’ , ‘Last Record’, 

‘Next Record’, ‘Previous Record’ button«Next Record». 
• Once you are satisfied with the output you can actually merge the 

documents. 
20. Click ‘Start Mail Merge’ button, Fig as shown will appear.       
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21. Select ‘New Document’ option from the ‘Merge to’ list box. 
22. Click ‘All’ option from ‘Record to be merged’ group. 
23. Click ‘Merge’ button to actually merge the documents. 
24. A new document with the name ‘Forms Letter1.doc’ will be created. 
25. Save the forms letter1.doc. 
 
The merged document can also be directed to the printer. You can also check 
for error in the merged documents by clicking ‘Check for error’ button. 
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Microsoft Excel 2000 
 
Lab - 1 
 
1.1 Create a workbook called Lab1? 

 
1.      Click on File option on the Menu bar. 
2. Click on New. 
3. A Dialogue box will appear. 
4. Select the book and Click OK. 
5. A new Excel Book will open 
6. Open the File menu Click the Save as Option. 
 

 
 

 
7. Give the name as Lab1 and click OK. 

1.2  Enter the text  “Radiant Software” on Cell A1 
 

1.    Click on Cell A1. 

2. Enter the Text “Radiant Software” 
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3. You will see that text appears on the Formula Bar as shown in Fig. 

 
 
 

1.3 Similarly enter the text as shown in Fig. 

 
 

1.4 Entering Numbers 
 
1. Click on Cell A7. 
2. Type the number “1” in the Cell. 

Formula Bar 
A bar near the top of the window that 
displays the constant value or formula 
used in the active cell. To enter or edit 
values or formulas, select a cell, type 
the data and then press ENTER You



 
 
 
 

Lab Exercises and Solutions 

Centre for Information Technology and Engineering, Manonmaniam Sundaranar University  39 

3. Now Click on Cell C7 and type number 27. 
4. Complete the worksheet as shown in Fig. 

 
1.5 Formatting  the Text 

To change the Font size, Font type, Font Format , follow the steps given 
below. 
1. Click on the cell whose text format has to be changed . Here click on the 

Heading “Radiant Software ” i.e Cell A1 
 

1.6 Increasing Font size 
1. To increase Font size, click on the Font Size tool of the Format Tool bar. 

2. Change the Font size number to 10 as in Fig 
1.7 Changing the Font type 

1. After selecting the cell whose Font type is to be changed , Click on the Font 
name tool to the right . 

 
2. Select any font type (for example select Arial), from the list of font names 

available with Office 2000. 
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1.8 Changing the Font Format 

To make the text Bold, Italic, Underlined, follow the steps given below: 
 

1. Select the text to which the formatting is to be done. 
2. To make the selected text Bold, click on the Bold icon. 
3. To make the selected text Italic, click on the Italic icon. 
4. To understand the selected text, click on the Underline icon. 
 

 A number of cells can be formatted at the same time by dragging the 
mouse cursor from the desired cell to the cell till where the formatting is to 
be done, by keeping the left mouse button pressed. 

 
Make the Column headings Bold, The Heading, “ Employee Personal Details” 
Italic and underlined to the contents of the currently prepared worksheet, using the 
above steps. The worksheet will now look like Fig. 

 
1.9 Setting Alignments of text 

To align the text contents of a column with left, center or right Alignment , 
follow the steps given below. 
 

 Make the Cells of column S.no and Sex  as center aligned. Make cells of 
Column Name ,Blood Group and Height as Left aligned. Make the cells 
of columns for Age and Weight Right aligned. 

1. Click and select the cell or cells where the alignment is to be made. 
2. To make the selected text left aligned, click on the left align icon. 
3. To make the selected text center aligned, click on the center align icon. 
4. To underline the selected text right aligned, click on the right align icon. 
5. The worksheet will now look like this. 
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 Sometimes the text is required to be merged into one within a number of 

columns, for example , “Radiant Software” has to appear at the center of 
the columns A,B,C,D,E,F,G instead of keeping it left aligned . To perform 
merge and center text, Perform the following steps: 

2. Click on the cell of the text which is to be Center Merged. Here select the 
cells from Cell A1 to Cell G1. 

3. Select and Drag the cursor from Cell A1 to Cell G1, till where the text is to 
be center merged. 

 
4. Click on the Center Merge icon. The worksheet will now look like Fig. 

 
 

1.10   Selecting Multiple Cells 
 

1. Click on the Cell from where the selection is to be made. 
2. Drag the cursor from the Cell ,which is just selected, to the cell where the 

selection is to be made. 
3. You may Cut, Copy, Paste or Align the text contents as per requirements. 
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Lab 2  
 
2.1 Writing Simple Formula 
 

 Add another column “Basic” to the worksheet and enter the data as shown 

in Fig. 
 
 

1. Click on the Cell in which the formula is to be written. 
2. Take your cursor to the formula bar and write the formula as per the 

requirements. 
 
 For example 

 
• Click on Cell H14. 
• Type the following formula at the Formula Bar: 
 
h6+h7+h8+h9+h10+h11+h12+h13 or type Sum (h6:h13) and click on the equal 
to sign  
 

 
 
1.  In the dialogue box which appears, if you find that the answer is right, 

Click on OK. 
 
2. You may even sum the contents of the cells using the following steps: 

 
 Select the cells from Cell H6 to H13. 
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 Click on the icon  

 
 Note that you use any one of the above procedures. If you are 

practicing both, see to it that the result of the earlier one must be 

deleted. Else it may sometimes get added to the original and get 
erroneous answers. 

 
 

 Note 
After clicking on, if           the Formula is wrong click on           . If the Formula 
and Answer is correct, click on. 

 
2.2 Inserting a Column 
 

Insert a Column before the Column for Basic and enter the Values for Date as 
shown in Fig. 

 Hint 
 
To insert a column, Click on any cell of the column to the left of which the 
new column is to be inserted. Now Select Insert option on the Main Menu bar 
and Click on Columns option . A new column will be inserted. 

You 
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Lab 3 
 
 Writing Complex Formula 

• Create Columns for HRA, Bonus ,PF, Total Years and Net Pay  as shown 
in Fig 

 
1. Click on the Cell , where the formula is to be Utilized , Here Cell J6. 
2. Click on. 
3. Click on the drop down button of the Function and Select More Functions-

>Logical ->  If clause. 
4. In the If dialogue box which appears, fill the text boxes with the conditions 

as shown in Fig. 
 

• This is to get Bonus =4% of  Basic, for a Basic >=4000 and Bonus = 1.5% of 
Basic , for basic<4000. 
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• This is to get HRA of Rs 1500 if the Basic is more than or equal to         Rs. 

4000 or Rs 800 , if HRA is less than 4000. 
 
Exercise: 
 
Complete the Worksheet as given in the First Fig. Apply the formula below: 
The Formulas are as follows: 

 
o P.F> = (12% of Basic) if Basic >= 4000 else P.F. = 0. 
o Total years = 1999 – YEAR(H6) 
o Net Pay = I6+I7+K7-L7 
 
Copying Formulas in the rest of the Cells 
 
To copy the Formula, (which has been defined for a particular cell) to the 
other cells under the same column, perform the following steps. 

 
1. After the formula in a certain cell has been defined, for example cell J6 , 

click on the right bottom side of the selected cell on the ‘+ sign’. 
 
2. Keeping the left mouse button clicked, drag the cursor to the cell to which 

the formula has to be applied. Here till Cell J13. 
 
3. Leave the left mouse button to fill the cells with the result of the selected 

formula. 
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The same process can be used to fill the cells under the other columns. You 
are required to try for the columns on HRA, Bonus, P.F, Total Years and Net 
Pay. 
 
How To Edit Formula? 
 
1. Click on the Cell to which the correction of Formula has to be performed. 
 
2. Click on the icon on       the Formula Bar. 
 
3. The Formula Box which was earlier used to create the Formula, will 

appear. To this perform the changes if any, to the formula specified. 
 
4. Click OK button of that Formula dialogueue box. 
 

Lab - 4 
 
4.1Applying Formatting features to numbers 

 
Suppose you are required to add Rs. to all the amount related cells, follow the 
steps. 
 
1. Select the cells to which the special formatting is to be applied . 
2. Click on Format option on the Main Menu bar and Select Cells. A dialogue 

box appears as shown in Fig. 
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4. Click on Currency option in the category section of the Number tab page. 
The Format cell dialogue box will look like the above Fig.Click on  

5. Click on OK to select the Currency settings to the selected Cells. 
 

 This will place the ‘$ sign’ in the Cells which were selected. 
 

 Perform the same steps for all the columns which are related to amount 
i.e Columns I,J,K,L and column N. The Final worksheet should look 
like  in the Fig. 

 
To change the ‘$ sign’ to Rs. follow the steps  

 
1. Click the Start Button. 
 
2. Select Settings-> Control panel. The Control Panel window appears. 
 
3. Double click on Regional setting icon. The Regional Property dialogue box 

appears. 
 
4. Click on Currency tab page in the Regional Settings Property dialogue 

box. 
 
5. Delete the ‘$ sign’ in the Currency symbol and type Rs. as shown in Fig. 
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6. Click Apply and then click on OK. The ‘$’ sign in your worksheet will now be 
replaced by ‘Rs’. Now the Worksheet will look as shown in Fig. 

 
 
 

Lab 5 
 
5.1 Formatting the Text 

 
1. Click on the File option from the Menu bar. 

2. Select New option-> Click OK to the dialogue box which appears. 
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3. Enter the values as shown in Fig. 

 
 
5.2 Changing the Column width 

 
To change the width of the columns according to the text written in the cell, 
perform the following steps: 
 
1. Click on the Column Heading Bar at column A.  

2. Drag the cursor to the right by keeping  the left mouse button pressed to 
fit the characters in the box. 

3. In Column A make sure that “Product Name” should be visible. 

4. Similarly arrange all the other columns according to the text in the 
corresponding columns 
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5.3 Changing Row Height  
 

1. Select any cell of the row, the height of which has to be increased. Here 
select row 3. 

2. Click on Format option from the main menu. 
3. Select Row option and then click on Height option. Refer the Fig. 

 
  

4. Enter the value of row height and click on OK. Here the value entered is 
24. 

 

 
 

5. It can also be increased by right clicking on row 3 when you get the pop 
up menu as shown in Fig. 
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6. Select Row height and increase the value of  the row height as done in step 

3 & 4 
 

5.4 Inserting and Deleting Rows 
 

Suppose you wish to enter a new row before the row which contains 
Windows NT. To insert a new row for Office 97, perform the following steps. 
 
1. Click on the Windows 98 .i.e. Cell A8. 
2. Click on Insert and Select row. 

 
 A row will be added above Cell A8. The Windows 98 Cell will now 

become Cell A9. 
 
3.   Enter the Remaining Entries as shown in Fig. 
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Deleting Rows 
 
Before proceeding for this exercise, insert a row after Office 2000 (i.e. after row 
12) by following the steps given above and then enter the values as given 
below: MS Access    250  100  25000 Now the worksheet looks as shown in Fig. 

 
 

1. To delete a row, Click on the row, which is to be deleted. Here click row 
13. 

2. Select Edit option on the Main menu. 
3. Select the Delete Option. 
4. Now the Work Sheet will look like this. 



 
 
 
 

Lab Exercises and Solutions 

Centre for Information Technology and Engineering, Manonmaniam Sundaranar University  53 

 
 

5.5 Inserting and deleting Columns 
 
Suppose a new Column is to be inserted for a Manufacturer field before Sales. 
Follow the steps given below. 

 
1. Click On Cell for Sales i.e. Cell D5. 
2. Click on “Insert” option on the Main menu and then select the “Columns” 

option. 
 

 A new column will be inserted before the column Sales as shown in 
Fig. 

 
Exercise: 
 

 Type “Manufacturer” as the heading for this column in Cell D5. 
 

 Enter some data in the cells for column D under “Manufacturer” as 
shown in Fig. 

 
 Insert a column for City after the Manufacturer Column, and give it a 

heading called as “City” i.e. in Cell E5 . Enter some city names in the 
cells from Cell E7 to E12. 

 
 If you want to delete any column, click on any cell on that column. 
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 Here we select a cell say Cell E5 of the newly created column E for 
City. 

 
 Click on Edit option on the Main Menu->delete-> entire column and 

click on OK. 

 
5.6 Moving and Copying Cell Contents 

 
To copy contents of a cell to some other cell other than the adjacent cells. 
 
Exercise: 
 
Insert a new row for City and type some cities in that column as shown in Fig. 

 
1. Click on the Cell B5 whose contents are to be copied. 
2. Click on Edit option on the Main Menu and select Copy option. 
3. To copy the contents to the other cell , Click on that particular cell. 
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4. Click on Edit option on the Main Menu and Select Paste option. 
 
To copy contents into adjacent cells follow the steps given below. 
 
1. Click on the cell whose contents are to be copied. Here click on cell B6. 
2. Keep the left mouse button pressed on the right bottom corner of the cell 

when you see a bold ‘plus sign’. 
3. While keeping the left mouse button pressed, drag the cell down to cell 

B12 . 
4. Now click outside the selected area to view the copied contents. 
 

5.7 Transferring Data between Worksheets 
 
1. Select the cells A1 to A13 whose data is to be copied to another worksheet. 
2. Copy the contents by clicking on Edit->Copy or Right click on the mouse 

and select copy. 
3. Move to the other workbook by clicking on Sheet 2. 
 

  
1. Click on the cell from where the contents are to be pasted. Here click on 

cell A1. 
2. Click on Edit->Paste Special and follow  the Fig and click OK. 
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5.8  Transferring Data between Workbooks 
 
1. Open a new workbook. 
2. Go to the old workbook. Select all the cells from Cell A1 to F13, of the 

workbook just created. 
3. Copy the contents by Clicking on Edit option->Copy or you may ever 

Right Click on the mouse and select copy. 
4. Now move to the new workbook and click to Cell A1. 
5. Click on Edit->Paste Special. Click OK on the dialogue box opened. 

 
 
Lab - 6 
 
6.1Create a Work Sheet For “Cool Bar “ 

 
1. Open a new workbook. 
2. Enter the following values as shown in Fig. to the worksheet which is 

newly opened. 
3. The final worksheet must look as shown in Fig. 
 

 
6.2 Relative References 

 
To calculate formula for a cell, perform the following steps: 
 
1. Click on Cell C14. 

2. Type the following formula at the formula bar as shown in Fig. 

        =C5+C8+C11 



 
 
 
 

Lab Exercises and Solutions 

Centre for Information Technology and Engineering, Manonmaniam Sundaranar University  57 

 

 
3. Click on the ‘+ Sign’ on the right bottom corner of Cell C14 and select the 

cells up to cell C17 by dragging the mouse while keeping the left mouse 
button pressed. 

4. Again click on Cell C14. 

5. Click on the ‘+ sign’ and select the Cells to the right up to Cell F14. 

6. Now Click on Cell C15 . 

7. Click on the ‘+ sign’ and select the cells to the right up to cell F15. 

8. Now click on Cell C16. 

9. Click on the ‘+ sign’ and select the cells to the right up to cell F16. 

10. Now Your Cool Bar Work Sheet will look like this. 

 
 
6.3 For the Column on “Total” , follow the steps given below: 

 
1. Click on Cell G5. 

2. Type the following formula in the Formula bar 

=C5+D5+E5+F5 
3.     Press Enter. 

4. Click on Cell G5. 

5. Click on the ‘+sign’ at the right bottom of the selected cell and drag the 
cursor downward till cell G16. 
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6. Now the Fig will look like this. 

 
6.4 To calculate the Grand total follow the steps given below 

 
1. Click on Cell C14 and select the Cells till Cell C17. 
 

2. Click on the summation icon  on the Format Menu bar. This will 
produce the result of the summation in Cell C17. 

 
3. Similarly calculate the summation for cells D17 to G17. 

 
4. Now the Fig will look like this. 
 

 
6.5 Absolute references 
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To give Absolute reference to a cell, follow the steps given below. 
 
1. Click on Cell H5. 

2. Type the formula given below. 
        =G5/G17 
3. Press Enter. The Cell H5 will now have the result of the formula. 

4. The Work Sheet will look like this. 

 
 

6.6 Creating a Range 
 
To create a range for a definite number of cells follow the steps given below. 
Using Define name Dialogue Box 

 
1. Select Cell C5 to C8. 

2. Click on Insert option on the Menu Bar. 

3. Select the option Name->Define. 

4. In the Define Name dialogue box, type “cat” in the Names in workbook 
text box as shown in Fig. 

5. Click on OK. So you can now access the cells Cell C6 to C8 by the name 
“cat” 
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 These naming of cells play an important role when you go for Bigger 
Calculations. 

 
6.7 Creating Names from a row or column 

 
1. Click on Cell C4. 
2. Select cells till Cell F7. 
3. Click on Insert->Name->Create 
4. Select Top Row and Left Row in the Create Names Dialogue Box as shown 

in Fig. 
5. Click OK. 
6. Select Insert->Name->Define… 
7. Select Quarter 1 as shown in Fig. 
                                           

 
 

 This means that the top row and left column provide names for the range. 
Thus Five named ranges are created. Thus 5 named ranges are created (3 
row labels and 2 column labels). 
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Lab 7 
 

7.1 Using Excel Financial Function 
 
1. Open a new Worksheet and enter the values as shown in Fig. 

 

 
 
2. Click on Cell B8. 

3. Click on the equal to icon . 
 
4. In the Formula Box, Select More Options…..->Financials->FV. 
 
5. Insert the formula as shown in Fig FV dialogue box which appears. 
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Exercise: 
 
Using the methods shown above calculate the monthly installment for the 
loan taken i.e. $50,000 for a specific amount of time i.e. 5 years and at the 
given Rate of interest which is  12%. 
 
Hint :  Use PMT Function which is a subset of Financial Functions. 
 

7.2 Goal Seek: 
 
In the above example you will yield a future value of $42,469.31 if you save a 
value of $1000 per month. Suppose you wish to obtain a round sum of $40000 
in the period of 3 years. To know the monthly deposit to seek this round sum 
you require to use the Goal Seek option in the Tool menu bar. 
 
1. Click on Cell B8. 
2. Select Tools->Goal Seek. 
3. Enter the values in the text boxes as given in Fig. 
 

 
 

 
 
4. You may even select  the Cells for the textbox “Set Cell” and for “By 

changing cell”.  This can be done by click on the Collapse dialogue box 
icon . 

 
5. Then click on Cell B8, Again Click on the collapse dialogue box icon to 

come back to the Goal Seek dialogue box. 
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6. After the entry is complete , Click on OK. 
 

• When you Click OK, you will get the monthly deposit to yield the 
value of $40,000 in 3 years which comes to $ 941.85. 

 
7.3 Using Common Statistical Function  

 
Let us take the detailed report of Survey conducted to Sell a certain Product. 
 
1. Create a simple Worksheet as shown in Fig. 

 
 
2. To make the Customer no. center aligned, Select the Cells from Cell A6 to 

Cell A17 and click on the align center button on the Format menu bar. 
 
You are now required to find the survey conducted on how many persons, 
the average amount Quoted by the persons, to find what is the best price that 
can be paid for the product, to find the mean of the total amount quoted. 
Follow the steps given below: 



 
 
 
 
Computer Fundamentals and Office Automation 

         Centre for Information Technology and Engineering, Manonmaniam Sundaranar University 64 
 

1. Click on Cell A19 and type “Number of Persons Surveyed”. Similarly type 
“Mean Average”, “Median” , “Mode” in Cells A20,A21,A22. 

 
2. The Complete Worksheet must now look as shown in Fig. 

 
 
Now to apply the Formula to these, perform the steps shown below. 
 
1. Click on Cell C17. 
2. Click on the “=sign” or the edit-formula on the Formula Bar, the function 

button is displayed. 

 
3. Click on More Functions. 

4. In the Function Category , Select Statistical ->Count (in Function name). 

5. Click OK. 



 
 
 
 

Lab Exercises and Solutions 

Centre for Information Technology and Engineering, Manonmaniam Sundaranar University  65 

6. In the Dialogue box, which appears , type “C6:C15” in the first text box. 

7. Click OK to get the number of Surveys conducted. And the Fig will look 

like this. 

 

 
 
Tip 
 
After completing this, try entering “B6:B15” in the text box for Value 1 where 
you entered “C6:C15” , just now. 
 

Did you get the answer? What was it, Zero! But you had 10 entries for the 
survey conducted. So the answer is wrong. This is because the Function 
COUNT only recognizes numerical entries. To correct the mistake, use the 
function COUNTA instead of the function COUNT. You can access COUNTA 
in the same way More Functions->Statistical->COUNTA. 
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Exercise: 
 
You are required to fill in the remaining cells for Mean Average, Median, 
Mode using the steps shown above. The changes that you will have to bring 
are in the selection of the items inside Statistical Function. For “Mean 
Average”, select the Average Function. 
 
For “Median” select Median function and for “Mode”, select the Mode 
function.  
 
The final Work sheet should now look like Fig. 

 
 
Lab 8 

 
8.1.Create a worksheet to display the marks obtained by the students John, Dick, 

Julian, Rebecca in the subjects Math and Physics as shown in Fig. 
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8.2 Creating Charts 
 

Creating Column Charts 
1. Select the cells from Cell A2 to Cell E4. 
2. Click on Insert->Chart… 

 
3. Select the Column Chart as shown in Fig. and then click on Finish. A 

graph will appear as shown in Fig. 
Column Charts 
4. Delete the chart just created by clicking on the chart and then pressing 

Delete button. 
1. Again perform steps 1 & 2. 
2. Select the different chart types and view the different charts obtained 

as shown in Fig. 
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Bar Chart 
  
 
 
 
 
 
 
 
 
 
 
 
Line Chart 
 

 
 
 
 
 
 
 
 
 
 

0

20

40

60

80

100

120

Kumar Suresh Guna Gautham

Maths

Physics

0 50 100 150

Kumar

Suresh

Guna

Gautham

Physics
Maths

Maths

Kumar
Suresh
Guna
Gautham



 
 
 
 

Lab Exercises and Solutions 

Centre for Information Technology and Engineering, Manonmaniam Sundaranar University  69 

 

 Pie Chart 
Cylinder Chart 

 
8.3 Using Stock Charts 
 

These charts are used for presenting Scientific, Statistical and Financial data. 
Stock Charts 
 
These charts need a minimum of three values. 
 
1. Select Sheet2, You are now in a new worksheet. 
 
2. Create a database as shown in Fig. 

 
  
3. Select the cells from Cell A3 to Cell D6. 

 

4. Click on the chart icon    on the Tool Menu Bar. The Chart Wizard 
appears. 
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5. Select the Stock Chart option and click on the first chart option as shown 
in Fig. 

 
6. Click on Next. 
7. In the dialogue box which appears as shown in Fig. Select Next.                  

 

 
8. In the Chart option Dialogue box which appears give the Chart title and 

the X-axis and the Y-axis titles as shown in Fig.                 
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9. Select the sheet where you wish the chart to be created. Here we select –As 

new sheet 
 
 
10. Click on Finish in the Step 4 of 4 Chart Wizard dialogue box.                     

 
 
11. The Final Chart will look like the chart as shown in Fig. 
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Lab 9 
 
 Preparing Excel Data for Web Publication 

 
Save the original worksheet or item on the worksheet before it is published or 
saved as a web page. If an entire workbook is saved, it can be opened later in 
Excel without losing any features. When it is then published or saved, the .xls 
file remains on the hard disk, and Excel creates a new HTML-format (.htm) 
file in the location specified. The data can be placed on the web with or 
without interactive functionality. 
 
Before data with interactive functionality is placed on the web, make sure that 
the correct data appears in Excel and it is complete and accurate. Because 
some formatting does not appear the same way in Excel as it does on the web, 
it is better to format the data using FrontPage 2000 or data access page Design 
view in Access 2000 after it is published or saved . If the actual data must be 
changed , use Excel. 
 
Publishing Excel Data on the Web 
 
Note that changes to external data ranges will not be reflected on the web 
page when the data is published without interactive functionality enabled. 
Interactivity must be added with PivotTable functionality to put a refreshable 
external data range on a web page. 
 
Preview the data(File/Web Page Preview) in the browser before saving or 
publishing it. To preview the page in interactive form, select the Open 
published web page in browser check box before clicking the Publish button. 
If the data does not appear as desired, open the original workbook (.xls), 
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modify the data, and preview  the web page again. Remember that some 
formatting and features appear differently in web pages than they do in Excel 
due to the native language capabilities , or limitations, of the web 
programming language HTML. Preview the  web page with every browser 
that may be available to the users. 
The workbook (.xls) can be saved directly to an Internet address. If all of the 
potential users of the workbook have Excel installed on their computers, or if 
the data is wanted in Excel format rather than HTML format, keep the data as 
an .xls file. 
 
In this activity you view a previously saved file as a web page and 
save/publish it as an interactive web page. 
 
1. Open Lab1.xls : Click on File|Open , and select the particular File. 

 
2. After the file opens, click on File|Web Page Preview . Verify your view 

with the following illustration. Yes, you opened the file in the particular 
Folder but the browser shows another directory. This is normal as the 
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browser copies the file to the temp directory . This table looks okay in the 
web preview  view. 

3. Close the browser. 
4. Now we will save the file as a web page before looking at it in the 

browser. In Excel, click on File|Save As . In the Save as type box, select 
(*.htm; *.html) Web Page. Notice the dialogue changes and a Publish 
button appears on the lower right side of the dialogue. 

 

 

5. Click on Publish icon   
6. Enable Add interactivity with by clicking on the check box and selecting 

Spreadsheet functionality  in the drop-down box. If you do not want web 
users to change the data, do not enable Add interactivity with. Click on the 
Open published web page in browser check box. 
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7. Click on Publish. Now the Excel sheet is published as an interactive web 
page and can be viewed in the browser. Start your web browser and open 
Page.htm in the particular directory. 

 
 

8. Page.htm was published interactively. Move the cursor to a cell, type in some 
value, then move the cursor to another location. Did the original location’s 
value change? If so, we succeeded. 
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MicrosofT PowerPoint 2000 
 
 
Lab 1 
 
 
1.1 Starting PowerPoint 

 
To Start PowerPoint, follow these steps: 
 
1. Click on the ‘Start’ button. 
2. Select the ‘Programs’ option. 
3. Click the option ‘Microsoft PowerPoint’ screen as shown in Fig. 
 

 
  

1.2 Creating Presentation using blank Presentation 
 
1. Select ‘Blank Presentation’, screen as shown in Fig.                  
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2. Click on the first layout from the new slide dialogue box. 
3. Click ‘OK’ button. 
4. Click ‘Add to title’ to add the title, enter ‘Radiant Software’ as title .See the 

Fig. 
5. Click ‘to add Subtitle’ to add the subtitle enter ‘Ray of Hope’. 

 
 

1.3 Create the Second slide 
 
1. Select ‘Insert’ option from Main Menu. 
2. Click ‘New Slide’ option screen. 
3. Click ‘Bulleted Slid’ box. 
4. Click ‘OK’ button. 
5. Enter the title. 
6. Enter ‘Education’ , ‘Research & Development’ , ‘Content Development’ 
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1.4 Create a Third Slide 
 
1. Create third slide and choose ‘Table’ style. 
2. Enter the Company’s name in the title box. 
3. Double click on table picture to prepare the table, as shown in Fig, Insert 

Table  dialogue box appears. 
4. Enter number of columns as 2 and number of rows as 4. 
5. A table gets inserted in the slide. 
6. Enter the data as shown in Fig. 
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1.5 Create Fourth Slide 
 

1. Create a new slide and choose ‘Organization Chart’ style. 
2. Enter the title in the title bar. 
3. Double click the icon to modify the organization chart. See the Fig . 

 
4. After the entire organization chart is ready, close the window. 
5. A dialogue box prompts you whether to put the chart on the slide or not. 
6. Click ‘Yes’ button. 

1.6 Create a Fifth Slide 
 
1. Create a new slide. 

2. Select ‘Text & Clip art’ style 

3. Enter the title as shown in Fig. 
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4. Enter the text as shown in Fig. 

5. Double click to add the clip art at the end. The slide should look as shown 
in Fig. 

 
  
 
Now as the entire presentation is ready we are ready to view the presentation 
. The presentation can be seen using slide show. Perform the following steps 
to view the slide show. 
 
1. Select the first slide in the presentation. 

2. Select ‘Slide Show’ from Main Menu. 

3. Click ‘View Show’ form Main Menu. 

4. The slide show will begin, to view the next slide click the mouse button. 

 
Lab 2 
 
2.1 Creating a Presentation using AutoContent Wizard 

 
1. Select ‘File’ option from Main menu. 
2. Click ‘New’ option,  as shown. 
3. Click ‘AutoContent Wizard’ option. 
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4. Select ‘AutoContent Wizard’ option. 

 
 
5. Click ‘OK’ button .     
 
6. Click ‘Next’ button.        
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7. Click ‘Next’ button ,screen as shown in Fig. 

8. Click ‘Corporate’ button. 

9. Select ‘Company Meeting’ from the list. 

10. Click ‘Next’ button.      

 
11. Click ‘On-Screen Presentation’ option. 
12. Click ‘Next’ button.        
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13. Give the title to the presentation and footer if required. 
14. Click ‘Next’ button.          

 
 
 
15. Click ‘Finish’ button. 
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The presentation format is ready for you, which has to be modified to prepare the 
presentation the way you please. 
 
16.  Close the Presentation. 
 

2.4 Using Design Templates 
 
To work with the design template do the following steps: 
 
1. Select ‘File’ option from Main menu. 

2. Click ‘New’ option, screen as shown in Fig. 

3. Select ‘Design template’ tab. 

4. Click ‘Radar’ template. 

5. Click ‘OK’ button. 
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Now rest of the steps remains the same as working with blank presentation 
slides. 
 
 

2.5 Different views of Slides 
 
When you start working with any presentation in PowerPoint you are 
working with a normal mode. But you can view the slides in different modes . 
For changing the mode you have to work with the icon given on the status 
bar. The icon are shown in Fig. 
 
 
 
                                       
 
                                             
 
 

                                         
 
1. To view the presentation in outline mode click the outline view icon. 
 
2. To view one slide at a time click the slide view icon. Refer Fig. 
 

Normal 

Outline 

Slide Sorter 

Slide Show 
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The slide sorter view is shown in Fig. 

 
 
3. Close the presentation by selecting ‘File’ option from Main menu and click 

‘Close’ option. 
 
4. Exit PowerPoint by selecting ‘File’ option from Main menu and click ‘Exit’ 

option. 
 
2.6 Viewing Slide Master 

 
To view the Slide Master, do the following steps. 
 
1. Select the ‘File’ option from Main Menu. 

2. Click ‘Open’ option. 
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3. Select the presentation saved in the last lab session. 

4. Click ‘OK’ button. 

5. Select the ‘View’ option from Main Menu. 

6. Select ‘Master’ option. 

7. Select ‘Slide Master’ option, screen as shown in Fig. 

 

 
 

 
2.7 Customizing background of Slide Master 

 
1. Click the Master title text to change the background. 

2. Right click and select ‘Format Placeholder’ option screen as shown in Fig 
will be displayed. 

3. Select any color in ‘Fill Color’ list box. 

4. Click ‘Semi transparent’ check box. 

5. Click ‘OK’ button.                 
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The Background of the slide master gets changed thus changing the 
background of all the slides. 
 

2.8 Modify text 
 
1. Select second level of the bulleted text from the slide master. 
2. Right click on the text. 
3. Click ‘Font’ option, screen as shown in Fig. 

 
 
4. Select ‘Arial’ font and size as 34. 
5. Click ‘OK’ button. 
6. Close the slide master to reflect the changes elsewhere. 
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2.9 Adding footer to Slide 

 
1. Select ‘View’ option from Main menu. 
2. Click ‘Header & Footer’ option screen as shown in Fig.                 

 
3. Click ‘Date and Time’ check box. 
4. Click ‘Apply to all’ button. 
 
The footer is inserted in the slide master reflecting the effect on all the other 
slides. 
 

Lab - 3 
 

3.1 Making Handouts 
 
For creating and viewing handouts do the following steps. 
 
1. Select  ‘View’ option from Main Menu. 
2. Select ‘Master’ option. 
3. Click ‘Handout Master’ option, screen as shown in Fig. 
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For inserting date, header, footer and the page number do the following steps. 
 
4. Select ‘View’ option from Main Menu. 

5. Click ‘Header and Footer’. 

6. Select ‘Notes and Handout’ tab, as shown in Fig. 

 
 
3.2 Making Notes 

 
For creating and viewing notes perform the following steps. 
 
1. Select ‘View’ option from Main Menu. 

2. Select ‘Master’ option. 

3. Click ‘Notes Master’ option, screen as shown in Fig. 

4. Click ‘Update automatically’ option. 

5. Enter text in ‘Header’ textbox. 

6. Enter text in ‘Footer’ textbox. 

7. Click ‘Page number’ check box to display page number on the handouts. 

8. Click ‘Apply to All’ button. 
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3.3 Making Notes 
 

For creating and viewing notes perform the following  steps: 
 
1. Select ‘View’ option from Main Menu. 

2. Select ‘Master’ option. 

3. Click ‘Notes Master’ option. 

4. The top slide from the above figure is the slide master and the bottom 
slide is the notes body area where you can write the notes for the slides. 
You can create drawing objects, pictures, and headers and footers on the 
notes sides. 

 
Entering header, footer, date and page number remains same as we did for 
the handout master. 
 

3.4 Setting the Slide Timings 
 
For setting time gab between every slide you have to set the slide timings. 
Perform the following steps to do so: 
 
1. Select ‘Slide Show’ option from Main Menu. 
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2. Click ‘Rehearse Timing’ option. 
3. The slide with the Rehearse toolbar will be displayed as shown in Fig. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. The clock shows the time for every slide to be displayed. 
 
5. Click ‘Next’ button from the Rehearse Toolbar to set the time for the next 

slide. 
 
6. After the last slides time is set, a dialogue box as shown in Fig is prompted 

which show the total time for the entire presentation.  
 

 
 
7. Click on Yes button. 
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3.5 Drawing on Slides 
 
You can also draw on the slides when you are viewing the slide show as you 
can highlights the important points when the presentation is on. Perform the 
following steps to do so. 
 
1. Start the Slide Show. 

2. Right click anywhere on the slide. 

3. Select ‘Pointer Options’ from the popup menu. 

4. Click ‘Pen’ option. 

 
You will see that the pointer changes from an arrow to a pen. You can use this 
pen pointer to highlight any important points, during the slide show. You will 
also notice that the slide show will not proceed ahead according to the 
rehearse time. It will only continue when you again set the pointer to 
automatic. 
 

3.6 Customizing a Presentation 
 
To customize a presentation do the following steps: 

 
1. Select ‘Slide Show’ option from Main Menu. 
2. Click ‘Custom Shows’ option, screen in Fig. 
 

 
 
3. Click ‘New’ button, to create a new custom show. 
 
4. When you click on new button, a dialogue box as shown in Fig will 

appear.             
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5. PowerPoint will give the name as Custom Show1. 

6. Slides in presentation will display all the slides in the current presentation. 

7. Select the Slide you want to put in the custom show. 

8. Click ‘Add’ button to add the slide to custom show. 

9. Repeat the 7th and 8th steps for all the slides you want to have in the 
custom show. 

10. If you want to remove any slide from the selected custom show slides then 
click on ‘Remove’ button. 

 
You can also change the sequence of the slides in the custom show by clicking 
the ‘Up’ and ‘Down’ buttons on define custom show dialogue box. 
 
8. Click ‘OK’ button. 

9. The Custom Show Dialogue Box will be displayed. 

10. Click ‘Show’ button to view the custom slide show. 

 
3.7 Working with Graphs 

 
1. Create a new slide. 

2. Select any slide having chart in it. 

3. Double click on the chart icon. 

4. Modify the table as shown in Fig. by going to individual cells and 
changing the values. 
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5. Click outside the chart to see the graph. 

  
 

Lab 4 
 
4.1 Insert Objects and graphics 

 
You can add any graphics objects to the slide with the help of drawing 
toolbar. We can insert a WordArt text to improve the visual impact of the 
slide. Perform the following steps to do so. 
 
1. Insert a new slide. 
2. Click the ‘WordArt’ icon from drawing toolbar, as shown in Fig.            
 

 
3. Click your favorite style and click ‘OK’ button. 
4. Enter ‘Radiant Software’ as the text. 



 
 
 
 
Computer Fundamentals and Office Automation 

         Centre for Information Technology and Engineering, Manonmaniam Sundaranar University 96 
 

5. Click ‘OK’ button. 
6. Place the image properly on the slide. 

 
4.2 Adding Transition to the Slide 

 
1. Select the ‘Slide Show’ option from Main Menu. 
2. Click ‘Slide Transition’ option, as shown in Fig. 

 
 
3. Select the effect you want from the effect list box. 

4. Click ‘Slow’ radio button. 

5. Click ‘Apply’ to apply the change to the current slide. 

                                   Or 

Click ‘Apply to all’ if you want the same transition for all the slides. 

6. View your presentation using slide show to see the effect. 
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4.3 Adding Slide Animation 

 
1. Select the bulleted slide from the ‘Radiant Software’ presentation. 

2. Select ‘Slide Show’ option from Main Menu. 

3. Click ‘Custom Animation’ option, a dialogue box as shown in Fig will 
display. 

 

 
 
 

4. Click the ‘Title 1’ object you want to set the animation. 

5. Click the ‘Order & Timing’ tab. 

6. Click ‘Automatically’ option. 

7. Click ‘Preview’ option to view the effect. 

8. Click the ‘Effect’ tab. A dialogue box as shown in Fig will appear. 

9. Select ‘Fly’ option from ‘Entry Animation’ list. 

10. Select ‘From-bottom-right’ option. 

11. Click ‘Preview’ button. 

12. Click ‘OK’ button. 

 
4.4 Modify Slide Background Color and Fill Pattern 

 



 
 
 
 
Computer Fundamentals and Office Automation 

         Centre for Information Technology and Engineering, Manonmaniam Sundaranar University 98 
 

To change the background color and fill pattern of individual slides do the 
following steps: 
 
1. Right click on the slide for which you want to change the color. 

2. Select ‘Background’ option, a dialogue box as shown in Fig  will appear. 

 
3. Select the background color from the dropdown list. 
 
4. Click ‘Apply’ button. To change the fill pattern when you select the background 

color, there is an option for fill effects. 
5. Click ‘Fill Effects’, a dialogue box will appear as shown in Fig. 
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6. Click ‘Preset’ color option. 

7. Click ‘Diagonal up’ option from shading styles. 

8. Click ‘OK’ button. 

 
4.5 Saving Presentation 

 
To save the presentation, do the following steps. 
 
1. Select ‘File’ option from Main Menu. 
 
2. Click ‘Save’ option. 
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Microsoft Outlook 2000 
 

Lab 1  
 
1. How do you Set Appointments in Out Look? 
 

To schedule an appointment, perform the following steps. 
 

1. In Day view , select the day on which you want to schedule the 
appointment by clicking it. 

2. Select the appointment time. You might have to click the time planner’s 
scroll bar or use your up- and down- arrow keys to see the time you want. 

3. Double-click the appointment time to display the Appointment dialog 
box, as shown in Fig.   

 

 
 
4. Enter the appointment’s subject and location. Outlook 2000 keeps track of 

your locations as you add them, so you don’t have to retype them for 
subsequent appointments. (You need only to select them from the drop-
down list.)  

 
5. Set the start and stop times (use Tools, Options and click the Calendar 

options button to change the default of 30-minute appointments if you 
often have different appointment lengths) or clicks the All Day Event 
option if you want to schedule an all-day appointment. 
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6. Set your reminder time if you want a reminder. Outlook 2000 audibly and 
visibly reminds you of the appointment at the time you request. 

 
7. Click the Recurrence toolbar button if the appointment occurs regularly. 

Outlook 2000 displays the Appointment Recurrence dialog box as shown 
in Fig. Set the recurrence options to enable Outlook 2000 to schedule your 
recurring appointment. 

 
 

 
 
 
 
8. Click OK to close the Appointment Recurrence dialog box. 
 
9. Click the Save and Close button. Outlook 2000 displays your appointment 

in the time planner.         
 

 
 
Note: 
 

An appointment is an activity for which you reserve time but which 
does not require other people or resources. 

 

You could select Actions, New Recurring Appointment to 
go directly  to the Appointment Recurrence dialog box 
when you set up recurring appointments. 
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Exercise  
 

1. Create an Appointment of your own for a period of a month and if there is 
any   Recurrence, make use of Appointment Recurrence dialog box in 
Outlook. Try to remove and add some Appointments to the above task. 

 
2. Enter a series of appointments based on the following list. Use the current 

calendar year. Begin by starting Outlook and selecting the Calendar 
application. 

 
 
 
 
 
 
 
 
 
 
If you need to change a set appointment, double-click the appointment to 
display the Appointment dialog box, in which you can change the 
appointment details. Drag the appointment’s top or bottom edges from the 
time planner to increase or decrease the appointment’s duration. Drag the 
appointment’s side edges to change the appointment’s start time. 

 
You can remove an appointment at any time by right-clicking over the 
appointment to display a pop-up menu and then selecting Delete. 
 
Instead of using the Appointment dialog box to schedule an appointment, 
you can enter an appointment quickly by clicking the appointment time once 
to highlight it and entering the text for the appointment directly on the daily 
planner. When you press Enter, Outlook 2000 adds the appointment to the 
daily planner. 
 
Outlook 2000 reminds you of the appointment with an audible alarm 15 
minutes before the appointment . If you want to adjust the alarm lead time or 
make the alarm recurring , double-click the appointment entry to display the 
Appointment dialog box. 

Time Date Description Location Reminder Recurring 
9:00a.m.-
10:00 a.m 

11/10/2k Production 
Meeting 

Conf. Room B 15 min. Weekly 

1:00p.m- 
5:00p.m 

11/11/2k Hunting Udumalai  
Hill Station 

No No 

5:00p.m.-
7:00p.m 

11/12/2k Dinner with 
Madona 

Joe’s Barbecue-
Alvin 

15 min No 

9:00p.m-
11:00p.m 

11/13/2k Presentation John’s College 
 

No No 
 
 

4:00p.m- 
4:50p.m 

11/14/2k Dental 
Appointment 

Dr. Guna Sekar 15 min 6 months 
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Lab 2  
 
How  do you  Schedule a Meeting in Outlook? 
 
• In Outlook 2000 terminology, a meeting differs somewhat from an 

appointment.  
 
• Appointment is for you; it does not involve other resources (such as 

people and equipment) A meeting, however, requires that you schedule 
more people than yourself, and  perhaps requires that you reserve other 
resources (such as audio-visual equipment and a room in which to hold 
the meeting ). If you work in a networked environment, Outlook 2000 can 
scan other people’s computer schedules to help you plan meetings that 
others can attend. 

 
Note: 
 
A meeting is an appointment that involves other people and resources 
 
Follow these steps to schedule a meeting: 
 
1. Create an appointment for the meeting’s day and time. 
2. Click the Attendee Availability tab in the Appointment dialog box 
 

 
 
3. Click the Invite Others button and type( or select from the name list) the 

names of those attending. The list might include people or resources, such 
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as podiums. Outlook 2000 gets the names from your Contacts folder, but 
you can enter new names as needed. 

4. Use the scrollbars to view the free and busy times for the people you 
invite. You must also select the meeting time. Outlook 2000 shows you the 
attendees available free time when you click AutoPick , or you can use 
your mouse to schedule the attendees even if their free times all conflict. 
(Outlook 2000 adjusts for time zones if you invite someone from another 
time zone.) 

 
5. Click the Appointment tab to complete the dialog box. When you click 

Send, all recipients (if networked or available by email) get invited to your 
meeting by being sent the notes you entered on the Attendee Availability 
page. 

 
Exercise  

Create a Scheduled Meeting and invite all your friends through Mail. 
(Outlook) 

 
Lab 3 

How do you Scheduling Events in Outlook? 
 
An event is an activity not specifically tied to a time frame, such as a holiday 
or birthday. 
 
1. Select Actions, New All Day Event. The Event dialog box appears (looking 

very much like the Appointment dialog box) with the tabbed 
Appointment page displayed. 

 
2.  Schedule the event  as you do an appointment, but click the All Day Event 

check box to show that the event lasts the entire day (otherwise, the event 
automatically turns into an appointment). 

 
3. Select the Show Time As option if you want your Calendar to show the 

time as Busy or Out of Office time. 
 
4. Select an appropriate reminder time from the Reminder list, such as 2 

days, to receive an audible alarm and note reminding you of the event so 
that you can purchase gifts or prepare for the event in some other way. 

 
5. Click the Save and Close button to return to Calender. 
 
Exercise 
Make an Event about your friend’s Birth day. 
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Lab 4  
How do you manage a Task List? 
 
A task is any job that you need to track, perform, and monitor to completion. 
Outlook 2000 tasks (like appointments and meetings) might be recurring, or 
they might happen only once. You can manage your Outlook 2000 task list 
either from the Tasks folder in the Folder list or from the Calendar folder. 
 
 
 
To create a one-time task, perform these steps. 
 
1. Click the New Task toolbar button or select File, New, Task. You can 

create a task even faster by clicking the task list’s entry labeled Click Here 
to Add a Task. 

 
2. Enter a task description. 
 
3. Type the due date(the date you must complete the task, but not necessarily 

the day you perform the task.)  If you click the Due Date drop-down list, 
you can select from a calendar that Outlook 2000 converts your format to a 
supported date format. 

 
4. Further refine your task (if you need to) by double –clicking the task to 

display the Task dialog box, as shown in Fig . You can specify recurring 
tasks and assign priority. Click the Details tab to update the status of the 
task as you work on it. The Details page even tracks such task-related 
information as mileage, time involved and billing information.         

 

Unlike appointments, meetings , and events, tasks don’t belong to any 
specific date or time . Tasks are jobs you need to finish but are not 
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After you complete a task, click the task’s check box to cross the task from the 
list. Delete a task by selecting it and clicking the toolbar’s Delete button. 
 
 
 
 
 

 Best of Luck  

 

If you want to remind yourself of a task’s deadline, make an appointment for the 

deadline on the task’s due date. Set the alarm for 24-hours or 2 days. When the deadline 

draws near, you then are reminded that the task is wrapping up fast. 


